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Notations Used in This Guide

The following table shows the symbols used in this manual, along with descriptions of what they mean.

q Indicates additional information and points which may be useful to know regarding a topic. 

s Indicates a page where detailed information regarding a topic can be found. 

Procedure Indicates operating methods and the order of operations.

The procedure indicated should be carried out in the order of the numbered steps. 

[ (Name) ] Indicates the name of the buttons on the projector's remote control or the control panel.

Example: Esc button

"(Name)"

Timer (Boldface)

Indicates the name of the buttons on the EasyMP Monitor or OS screens.

Example:

Select "Timer" - "Timer Settings".
Select Timer - Timer Settings.
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EasyMP Monitor Features
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Tasks that can be done using EasyMP Monitor

EasyMP Monitor lets you carry out operations such as checking the 
status of multiple Epson projectors that are connected to a network and 
controlling the projectors from the computer.
Following are brief descriptions of the monitoring and control functions 
that can be carried out using EasyMP Monitor.
• Registering projectors for monitoring and control

Projectors on the network can be searched for automatically, and you 
can then select projectors to be registered from the projectors that are 
detected.
You can enter the IP addresses for target projectors to register them.

• Registered projectors can also be assigned to groups so that they can 
be monitored and controlled in groups.

• Monitoring the statuses of registered projectors
The power status (ON/OFF) for projectors and problems or warnings 
requiring attention can be checked visually by means of icons.
You can select groups of projectors or a single projector that you are 
interested in, and then check the cumulative lamp operating time or the 
details of information such as input sources, problems, and warnings 
for these projectors.

• Controlling registered projectors
Projectors can be selected in groups or as single projectors, and you can 
then carry out operations for the selected projectors such as turning the 
power on and off and switching their input sources.
Web control functions can be used to change the settings in the 
projector's configuration menu.
If there are certain control actions which are carried out regularly at 
particular times or on particular days, you can use Timer Settings to 
register timer settings.

• Mail notification function settings
You can set e-mail addresses to which notifications are sent if a status 
requiring attention, such as a problem, occurs with a projector that has 
been registered.

• Sending messages to registered projectors
You can send JPEG files to the registered projectors at once by using 
Message Broadcasting, which is a plug-in software for EasyMP 
Monitor.
To download the software and manual, visit www.epson.com, select 
your location, and select your product.
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Installing EasyMP Monitor

Operating environment

This software is compatible with computers that comply with the 
following requirements.

* Supports only 32 bit version of OS.

• Macintosh computers cannot be used.
• Operations carried out at the computer may become slow depending 

on the number of projectors being managed. If this happens, use a 
computer with higher specifications.

• EasyMP Monitor cannot be used in environments which do not allow 
pings to be transmitted.

Transferring the settings

If you are already using EasyMP or EMP Monitor, you can transfer the 
projector settings to this version. The settings are stored as a data file 
(EMP Monitor.dat). Make a copy of the EMP Monitor.dat before you 
install this software. EMP Monitor.dat can be found at the following 
location if the default settings were used to install the software: 
• If your operating system is Windows 2000 or Windows XP

"C:\Program Files\EPSON Projector\EasyMP (or EMP) Monitor Ver. 
x.xx (Ver. x.xx represents the software version)"

• If your operating system is Windows Vista, Windows 7, or Windows 10
"C:\Users\(User Name)\AppData\Local\VirtualStore\Program 
Files\EPSON Projector\EasyMP (or EMP) Monitor Ver. x.xx (Ver. x.xx 
represents the software version)"
If you cannot find the "AppData" folder, click "Start" - "Control Panel" 
- "Appearance and Personalization" - "Folder Options". Select "View" 
tab, and then configure the "Show hidden files, folders, and drives" 
setting in "Advanced settings".

q If your operating system is Windows 10, right-click "Start" and click 
"Control Panel".

OS Windows 2000 Professional SP4

Windows XP Home Edition SP2/SP3*

Windows XP Professional SP2/SP3*

Windows Vista*

(All editions except Starter Edition)

Windows Vista SP1/SP2*

(All editions except Starter Edition)

Windows 7 32 bit version
(All editions except Starter Edition)

Windows 7 64 bit version

Windows 8.x 32 bit version and 64 bit version

Windows 10 32 bit version and 64 bit version

• Internet Explorer Ver. 5.0 or later must be installed.

CPU Pentium MMX 166 MHz or higher (Pentium II 233 MHz 
or higher recommended)

Memory 
capacity

64 MB or more (128 MB or more recommended)

Free hard disk 
space

50 MB or more

Display SVGA (800 x 600) or higher resolution, 32 bit or higher 
display color
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• If your operating system is Windows 8.x
"C:\Users\(User Name)\AppData\Local\VirtualStore\Program 
Files\EPSON Projector\EasyMP (or EMP) Monitor Ver. x.xx (Ver. x.xx 
represents the software version)"
If you cannot find the "AppData" folder, from the Start menu, click 
"Control Panel" - "Appearance and Personalization" - "Folder Options". 
Select "View" tab, and then configure the "Show hidden files, folders, 
and drives" setting in "Advanced settings".

After installing this software, follow the instructions below before 
starting EasyMP Monitor to transfer the settings.
• If your operating system is Windows 2000 or Windows XP

Overwrite the existing EMP Monitor.dat file with the copy you made. 
The existing EMP Monitor.dat file is in "C:\Program Files\EPSON 
Projector\EasyMP Monitor Ver.x.xx".

• If your operating system is Windows Vista, Windows 7, Windows 8.x, 
or Windows 10
Place the copy of the EMP Monitor.dat file in "C:\Users\(User 
Name)\AppData\Local\VirtualStore\Program Files\EPSON 
Projector\EasyMP Monitor Ver.x.xx".

q The software name has been changed.
Before: EMP Monitor _ After: EasyMP Monitor
If you are already using EMP Monitor, you can replace with this software.

Installing

You must have administrator authority in order to install EasyMP 
Monitor.
To download the software and manual, visit www.epson.com and select 
your location.

Double-click the downloaded software file to start the install program. 
Follow the on-screen instructions.
If EasyMP or EMP Monitor is already installed, uninstall it before 
installing this software. s "Uninstalling EasyMP Monitor" p.48

Limitations imposed by a Windows Vista, Windows 7, 
Windows 8.x, or Windows 10 environment

When using EasyMP Monitor under Windows Vista, Windows 7, 
Windows 8.x, or Windows 10, note the following limitations.
• You must have administrator authority in order to use Register at 

startup on the Environment setup screen of EasyMP 
Monitor.s "Monitoring using the system tray" p.29

• If EasyMP Monitor is installed on your computer, uninstall it before 
you update the operating system to Windows Vista, Windows 7, 
Windows 8.x, or Windows 10. Updating your OS without uninstalling 
the software may cause a malfunction. s "Uninstalling EasyMP 
Monitor" p.48

Before starting operations

Check the following points before starting up EasyMP Monitor.
• EasyMP Monitor must be installed on the computer to be used for 

monitoring and control.
• The computer and the projectors must be connected to the network.
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• Depending on the projector model, a commercially-available serial W 
TCP/IP conversion adapter and a connection cable are required in 
order to use EasyMP Monitor. See your projector's User's Guide.
Make the settings for the serial W TCP/IP conversion adapter before 
connecting to the projector.

q To enable projectors to be monitored and controlled even when they are in 
standby mode*, make the following settings at the projectors. The settings 
that need to be made will vary depending on the projector you are using. 
See your User's Guide for more information.
• Set Standby Mode to Communication On (or Network On).
• Set Network Monitoring to On.
* When the projector's  indicator is lit orange.
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Using EasyMP Monitor
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Registering and deleting projectors for monitoring

This operation is carried out when starting EasyMP Monitor for the first 
time after it has been installed and when you would like to add 
projectors. Once a projector has been registered, the status for the 
projector will be displayed automatically each time EasyMP Monitor is 
started from that point onwards.
You can register up to 1,024 projectors or groups.
The operations to register projectors vary depending on where the 
projectors are connected on the network.
• When registering a projector that is located in the same segment as the 

computer in which EasyMP Monitor is installed. s "Registering 
projectors using automatic search (Searching for and registering 
projectors that are located in the same segment)" p.12

• When registering projectors that are in multiple segments of the 
network. s "Setting the range of addresses to do an automatic search 
and registration" p.15

Starting EasyMP Monitor

Procedure

A Use one of the following methods to start EasyMP Monitor.
If your operating system is Windows 2000, Windows XP, Windows 
Vista, or Windows 7
Click "Start" - "Programs" (or "All Programs") - "EPSON Projector" 
- "EasyMP Monitor Ver.x.xx" to start EasyMP Monitor.
If your operating system is Windows 8.x
From the Start menu , select "EasyMP Monitor Ver.x.x.xx" to start 
EasyMP Monitor.
If your operating system is Windows 10
Select "Start" - "All apps" - "EPSON Projector" - "EasyMP Monitor 
Ver.X.X.X", and start "EasyMP Monitor".
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B The main window will be displayed.
The red box area described in the screen below is referred to as 
Grouping view.

Registering projectors using automatic search 
(Searching for and registering projectors that are 
located in the same segment)

Procedures for automatic search

Procedure

A Right-click in Grouping view and select "New" - "Projector 
(automatic search)".
The following Create new projector (automatic registration) win-
dow will be displayed.
If Detail list view is displayed, select New - Projector (automatic 
search) from the Edit menu.
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B Click "Search".
Automatic searching will be carried out, and the names of the pro-
jectors that have been detected will be displayed.
If a projector does not appear in the list, use "Registration by spec-
ifying an IP address (Manual registration)". s p.18

q • You can also carry out this operation by selecting New - Projector 
(automatic search) from the Edit menu.

• Projectors that are using a serial W TCP/IP conversion adapter cannot be 
detected.
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Procedures for registration

Procedure

A Select the projector(s) to be registered from the displayed 
list, and then click "Edit".
The following window will be displayed.

Make the necessary settings while referring to the following table.

Display name Enter the name of the projector(s) to be 
displayed in Grouping view or Detail list view.

Up to a maximum of 32 bytes can be entered. A 
space cannot be used as the first character.

Display icon Select the icon(s) to be displayed in Grouping 
view or Detail list view.

Parent group Select when registering a projector in a group.

If no groups have been created, this cannot be 
selected.

s "Registering several projectors to a 
monitoring group all at once" p.19

Projector 
name

This shows the name that has been registered on 
the projector.

IP address This shows the IP address for the registered 
projector.

Use Serial W 
TCP/IP 
conversion 
adaptor.

This cannot be selected when registering 
projectors using automatic search.

Port Number This cannot be selected when registering 
projectors using automatic search.

Monitor 
Password

If a Monitor Password has been set for the 
projector, be sure to enter the Monitor Password 
that has been set. If the correct password is not 
entered at this time, it will not be possible to 
monitor and control the projector even though it 
is registered.
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B After entering the details, click "Register" to start the 
registration. When the message is displayed, click "OK".
To continue registering other projector(s), repeat steps 1 and 2.

q Projectors that have been registered using automatic search are searched 
for again by projector name each time EasyMP Monitor is started.

C To end the registration operation, click  in the top-right 
corner of the window or click "Cancel".
The icon(s) of the projector(s) you registered will be displayed in 
Grouping view or Detail list view.
Refer to s "Monitoring window layout" p.22 for details on using 
the Grouping view and Detail list view.

Setting the range of addresses to do an automatic 
search and registration

q Projectors that are using a serial W TCP/IP conversion adapter cannot be 
detected.

Procedures for automatic search

Procedure

A Right-click in Grouping view and select "New" - "Projector 
(automatic search)".
The Create new projector (automatic registration) window will be 
displayed.
If Detail list view is displayed, select New - Projector (automatic 
search) from the Edit menu.

B Select the "Specify an address range and search." check box 
and then enter "Start address" and "End address" in the 
range.

Description You can enter a memo about the projector. The 
details you enter here will be displayed at the 
projector properties.

Up to a maximum of 60 bytes can be entered.

Monitor Select this when you want monitoring to start.
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C Click "Search".
Automatic searching will be carried out, and the names of the pro-
jectors that have been detected will be displayed.
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Procedures for registration

Procedure

A Select the projector(s) to be registered from the displayed 
list, and then click "Edit".
The following window will be displayed.

Make the necessary settings while referring to the following table.

Display name Enter the name of the projector(s) to be 
displayed in Grouping view or Detail list view.

Up to a maximum of 32 bytes can be entered. A 
space cannot be used as the first character.

Display icon Select the icon(s) to be displayed in Grouping 
view or Detail list view.

Parent group Select when registering a projector in a group.

If no groups have been created, this cannot be 
selected.s "Registering several projectors to a 
monitoring group all at once" p.19

Projector 
name

This shows the name that has been registered on 
the projector.

IP address This shows the IP address for the registered 
projector.

Use Serial W 
TCP/IP 
conversion 
adaptor.

This cannot be selected when registering 
projectors using automatic search.

Port Number This cannot be selected when registering 
projectors using automatic search.

Monitor 
Password

If a Monitor Password has been set for the 
projector, be sure to enter the Monitor Password 
that has been set. If the correct password is not 
entered at this time, it will not be possible to 
monitor and control the projector even though it 
is registered.

Description You can enter a memo about the projector. The 
details you enter here will be displayed at the 
projector properties.

Up to a maximum of 60 bytes can be entered.

Monitor Select this when you want monitoring to start.
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B After entering the details, click "Register" to start the 
registration. When the message is displayed, click "OK".
To continue registering other projector(s), repeat Steps 1 and 2.

C To end the registration operation, click  in the top-right 
corner of the window or click "Cancel".
The icon(s) of the projector(s) you registered will be displayed in 
Grouping view or Detail list view.
Refer to s "Monitoring window layout" p.22 for details on using 
the Grouping view and Detail list view.

Registration by specifying an IP address (Manual 
registration)

Procedure

A Right-click in Grouping view and select "New" - "Projector 
(manual registration)".
The following window will be displayed.
If Detail list view is displayed, select New - Projector (manual reg-
istration) from the Edit menu.
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q You can also carry out this operation by selecting New - Projector (manual 
registration) from the Edit menu.

B Enter the IP address of the projector to be registered in the 
"IP address" box and then click "Search". When the message 
is displayed, click "OK".
If you are using a serial W TCP/IP conversion adapter and cable to 
connect the projector, select Use Serial W TCP/IP conversion 
adaptor, enter the port number in Port Number, and then click 
Search.

C After searching is complete, enter the information for the 
projector to be registered while referring to the table below.

D After entering the details, click "Register" to start the 
registration. When the message is displayed, click "OK".
The icon(s) of the projector(s) you registered will be displayed in 
Grouping view or Detail list view.

Registering several projectors to a monitoring group 
all at once

Projectors that have been registered can then be registered together into 
different groups so that they can be monitored and controlled together.
Furthermore, if you select one of the registered groups as the Parent 
group, monitoring and control operations can be carried out for all 
projectors in that Parent group.

Display name Enter the name of the projector(s) to be displayed 
in Grouping view or Detail list view. Up to a 
maximum of 32 bytes can be entered. A space 
cannot be used as the first character.

Display icon Select the icon(s) to be displayed in Grouping 
view or Detail list view.

Parent group Select when registering a projector in a group. If 
no groups have been created, this cannot be 
selected. (See the next section for more 
information on registering projectors to a group.)

Projector 
name

This shows the name that has been registered on 
the projector.

IP address This shows the IP address that you entered in step 
2.

Use Serial W 
TCP/IP 
conversion 
adaptor.

Select this if you are using a serial W TCP/IP 
conversion adapter to connect the projector.

Port Number If you are using a serial W TCP/IP conversion 
adapter to connect the projector, enter the port 
number.

Monitor 
Password

If a Monitor Password has been set for the 
projector, be sure to enter the Monitor Password 
that has been set. If the correct password is not 
entered at this time, it will not be possible to 
monitor and control the projector even though it 
is registered. If you are using a serial W TCP/IP 
conversion adapter to connect the projector, the 
Monitor Password security function cannot be 
used.

Description You can enter a memo about the projector. The 
details you enter here will be displayed at the 
projector properties.

Up to a maximum of 60 bytes can be entered.

Monitor Select this when you want monitoring to start.
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A Parent group can be set for other parent groups, so that a hierarchical 
group arrangement can be created.
First, create the registration groups, and then register projectors into the 
groups that have been created.

Procedure

A Right-click in Grouping view and select "New" - "Group".
The following window will be displayed.
Make the necessary settings while referring to the table below.
If Detail list view is displayed, select New - Group from the Edit 
menu.

q You can also carry out this operation by selecting New - Group from the 
Edit menu.

B When the setup is complete, click "Register" to start the 
registration. When the message is displayed, click "OK".
The icon(s) of the projector(s) you registered will be displayed in 
Grouping view.

C Right-click the projector icon(s) to register to the group you 
have created in Grouping view or Detail list view, and select 
"Edit".

q You can also carry out this operation by selecting Edit in the Edit menu.

D In the Edit projector window, select the group name to use 
for registering in Parent group and then click "Change".
The status of the group registration will be displayed as an icon in 
Grouping view.

q The registration details can also be checked using Projector list in the View 
menu.

Group name Enter the name of the group to be displayed in 
Grouping view or Detail list view.

Up to a maximum of 32 bytes can be entered. A 
space cannot be used as the first character.

Display icon Select the icon(s) to be displayed in Grouping 
view.

Parent group This selects the parent group. If no groups have 
been created, this cannot be selected.

Monitor Select this to monitor all projectors that have 
been registered in the group. If this is not 
selected, the settings made when the individual 
projectors were registered will be used.

It cannot be set when creating a new group.
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If the projector name or IP address changes after 
registration

For projectors that have been registered manually

Procedure

A Right-click on a projector icon in Grouping view or Detail list 
view and select "Monitoring disabled". Then right-click the 
projector icon again and select "Edit".

q You can also carry out these operations by using the Edit menu.

B If only the projector name has been changed, click "Search" 
in the Edit projector window that is displayed. If the IP 
address has been changed, enter the new IP address in the 
"IP address" box and then click "Search". When the message 
is displayed, click "OK".

C When the display returns to the Edit projector window, click 
"Change".

For projectors that have been registered using automatic 
search

Procedure

A Delete the projector(s) whose name or IP address has been 
changed in Grouping view or Detail list view. (See the next 
section for more information on deleting projectors.)

B Carry out automatic search to re-register the 
projector(s).s p.12

Cancelling projector registrations (Delete)

The registrations for projectors can be deleted if they are no longer 
required for monitoring or control using EasyMP Monitor.

Procedure

Right-click the icon for the projector or group that is to be deleted 
in Grouping view or Detail list view and select "Delete". When the 
message is displayed, click "OK".
More than one projector can be selected for deleting by selecting in 
Grouping view or Detail list view.
The methods of selecting more than one projector at the same time are as 
follows.
• If you select a Group icon in Grouping view, all projectors that have 

been registered in that group will be deleted at the same time.
• Hold down the Ctrl key on the keyboard while clicking on the desired 

icons.
• Use drag and drop to select a range of desired icons.

q You can also carry out this operation by selecting Delete in the Edit menu.
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Monitoring window layout

Types of monitoring windows and switching method

Types of monitoring windows

There are two types of monitoring windows. Select a desired window.
• Grouping view

This view lets you check the status of group registrations in a 
hierarchical diagram.

• Detail list view
This view lets you display the status of each projector as a list so that the 
projectors can be checked in detail. You can also display specific items 
as a list, and sort display items using a specific row as a sort key.

How to switch views

Grouping view and Detail list view are switched as follows.

Grouping view

Detail list view
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Procedure

Click the View menu, and select "Grouping view" or "Detail list 
view".

Monitoring using Grouping view

Meanings of Grouping view icons

In Grouping view, the patterns on the icons indicate the statuses of the 
projectors. If the group icons are round in shape, it indicates that there is 
another level below them. s p.24
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The icon patterns and their meanings are explained below.

*1 When Temperature level display group view is set to On at Environment 
setup in the Tool menu, an icon indicating the internal temperature of the 
projector will be displayed on top of the projector icon. The default setting 
is Off. As you can get an idea of how the temperature inside the projector is 
increasing when Temperature level is displayed, you can make 
improvements to the projector's operating environment before a high 
internal temperature error or high-temperature warning occur. s p.29

*2 Check the following items.
- Check that the projector's power is turned on.
- Check that the LAN cable is connected.
- Check that Standby Mode is set to Communication On (or Network On) 
or Network Monitoring is set to On in the projector's configuration menu.

*3 Check that the projector has been correctly connected to the network.

q The projector information that is generated when a problem is detected is 
stored until EasyMP Monitor is closed. EasyMP Monitor displays will not 
be updated automatically even if the projector status returns to normal. 
Click "Refresh" in the main window to update the status.

Using the icons in Grouping view

The following icon operations can be carried out in Grouping view.

Group

No warnings or problems
All projectors in the group are normal.

Warning or problem

A projector in the group has a warning or problem status.

Notification
A projector requiring immediate attention has been detected 
within the group.

Monitoring disabled
The projector is not being monitored. If you right-click the icon and 
select Monitoring enabled, the projector will be added to the 
projectors that are being monitored.

Data being updated 

Projector

No warnings or problems*1

Warning or problem

Notification

Monitoring disabled

Data being updated

Network error (Monitor Password authentication error)

No Monitor Password was entered when the projector was 
registered, or an incorrect Monitor Password was entered. s p.14, 
p.17, p.18

Network error (TCP connection error)*2

Network error (ESC/VP.net communication error)*3

Projector
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• Expanding and collapsing icons
Each time you double-click a group icon, the icons for the projector 
that have been registered in that group are displayed or hidden.

• Moving icons
To change the position of an icon within Grouping view, simply drag 
and drop the icon to be moved.

Monitoring using Detail list view

Meanings of Detail list view icons

The status of registered projectors is displayed as a list in Detail list view 
regardless of which Group the projectors belong to.
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The icon patterns and their meanings are explained below.

A Type

Displays the projector status.

No warnings or problems*1

Warning or problem

An error has occurred on the projector.

Notification

The projector requires immediate attention.

Monitoring disabled

The projector is not being monitored. If you right-click the icon 
and select Monitoring enabled, the projector will be added to 
the projectors that are being monitored.

Data being updated 

Network error (Monitor Password authentication error)

No Monitor Password was entered when the projector was 
registered, or an incorrect Monitor Password was entered. 
s p.14, p.17, p.18

Network error (TCP connection error)*2

Network error (ESC/VP.net communication error)*3

B Group name

When projectors are registered to a group, the name of the group that 
the projector belongs to is displayed.

C Display name

Shows the display name.

D Power

Shows the power on status for the projector.

Power on and normal status Power off and normal status

Power on and abnormal 
status

Power off and abnormal 
status

E Lamp Hours

Shows the lamp operating time for the projector. If the projector has 2 
lamps, it shows the lamp operating time for both lamp 1 and lamp 2.

F Temperature level

The following five icons display the differing internal temperature 
status of the projector.

Internal temperature 
normal

Internal temperature 
normal

High-temperature 
warning

High-temperature 
warning

Internal temperature 
error

G Error information

Shows a notification or warning/problem status using the following 
icons.

Clean Air Filter Notice Replace Lamp*4

Replace Lamp (Lamp 1) Replace Lamp (Lamp 2)

Lamp error (Lamp 1) Lamp error (Lamp 2)

Lamp failure at power on 
(Lamp 1)

Lamp failure at power on 
(Lamp 2)

High-temperature warning Replace Air Filter

No Air Filter Low Air Flow

Air Flow Sensor Err. Supply System Error (Ballast 
1)

Supply System Error (Ballast 
2)

Cinema filter warning

Shutter warning Lamp Cover Open

Lamp Error Lamp Error (Lamp 1)

Lamp Error (Lamp 2) Lamp failure at power on
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*1 When Temperature level display group view is set to On at Environment 
setup in the Tool menu, an icon indicating the internal temperature of the 
projector will be displayed on top of the projector icon. The default setting 
is Off.

*2 Check the following items.
- Check that the projector's power is turned on.
- Check that the LAN cable is connected.
- Check that Standby Mode is set to Communication On (or Network On) 
or Network Monitoring is set to On in the projector's configuration menu.

*3 Check that the projector has been correctly connected to the network.
*4 You can display Replace Lamp at any time by setting a preset in the 

Environment setup in the Tool menu.

q • The projector information that is generated when a problem is detected is 
stored until EasyMP Monitor is closed. EasyMP Monitor displays will not 
be updated automatically even if the projector status returns to normal. 
Click "Refresh" in the main window to update the status.

• Detectable error information differs with the projector you are using.

Selecting display items

You can select only the required items to be displayed in Detail list view.

Lamp failure at power on 
(Lamp 1)

Lamp failure at power on 
(Lamp 2)

High internal temperature 
error

Low air flow error

Air filter air flow sensor error Internal Error

Fan error Sensor error

Supply System Error 
(Ballast)

Supply System Error (Ballast 
1)

Supply System Error (Ballast 
2)

Auto Iris Error

Cinema filter error Shutter error

Cooling system error 
(Peltier element)

Cooling system error 
(pump)

Other error Obstacle Detection 
Warning

Exhaust vent shutter error Easy Interactive Function 
Error

Obstacle Detection Error Other Warning

Projector Direction Warning Lamp Mismatch Warning

Power Voltage error No Lens error

Phase Difference Plate error Lens Shift error

Laser error
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Procedure

A Select "Option" from the View menu.
The Option window will be displayed.

B Select the check box of the item you want to display.

C Click "OK".

D When all of the details of the item cannot be displayed in 
Detail list view, drag the boundary line on the right of the 
item name so that the view is extended to the desired width.

Sorting lists

You can sort detailed lists by using a specific row as a sort key, such as 
projector name order or IP address order.

Procedure

Click the item name of the row you want to use as the sort key.

Searching for desired icons (Projector list)

The Projector list feature is useful for searching in lists when many 
groups and projectors are registered and the icon you are looking for is 
not displayed on screen.

Procedure

Select "Projector list" from the View menu.
The following window will be displayed.
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With Projector list, temperature level icons are not displayed regardless 
of the setting of Temperature level display group view at Environment 
setup in the Tool menu.
The Projector list lets you check the registration details for groups in a 
hierarchical diagram. When you click on an icon, Grouping view and 
Detail list view are scrolled so that the selected icon is displayed in the 
window.

Monitoring using the system tray

The projector statuses are always displayed as icons in the system tray, 
even when Grouping view or Detail list view is not always displayed, and 
the statuses can be checked by the icon patterns.
When the configuration menus are set using the following operations, an 
icon appears in the system tray and the status can be monitored by means 
of the icon's pattern.

The icon patterns are explained below.

Procedure

A Select "Environment setup" from the Tool menu.
The Environment setup window will be displayed.

B Select "Resident in the task tray".

C Click "OK".

q • Right-click the icon in the system tray to open a pop-up menu to select the 
Open the main screen or Exit.

• If Register at startup in the Environment setup is selected, EasyMP 
Monitor starts automatically when the computer's power is turned on. 
When using EasyMP Monitor under Windows Vista, Windows 7, or 
Windows 8.x you must have administrator authority in order to use this 
function.

Displaying projectors with problem or warning 
statuses in a list

You can display a list of only the projectors which have a problem or 
warning status.

No problem Problem
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Procedure

Select "Warning and Error Projector list" from the View menu.
The following Warning and Error Projector list window will be 
displayed.
If you move the mouse pointer over the icon of the Error information, 
details of the error and the remedy will be displayed. If you double-click 
in a line, the properties for that projector will be displayed. s p.33
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The icon patterns and their meanings are explained below.

A Type

Shows the group or projector status.

No warnings or problems*1

Warning or problem

An error has occurred on the projector.

Notification

The projector requires immediate attention.

Monitoring disabled

The projector is not being monitored. If you right-click the icon 
and select Monitoring enabled, the projector will be added to 
the projectors that are being monitored.

Data being updated 

Network error (Monitor Password authentication error)

No Monitor Password was entered when the projector was 
registered, or an incorrect Monitor Password was entered. 
s p.14, p.17, p.18 

Network error (TCP connection error)*2

Network error (ESC/VP.net communication error)*3

B Display name

Shows the display name.

C Power

Shows the power on status for the projector.

Power on and normal status Power off and normal status

Power on and abnormal 
status

Power off and abnormal 
status

D Lamp Hours

Shows the lamp operating time for the projector.

E Source

Shows the input source that has been selected for the projector.

Computer or 
Computer1

Computer2

BNC S-Video

Video (RCA) Video (BNC)

SDI DisplayPort

DVI-D1 or HDMI1, 
DVI-D, HDMI*4

DVI-D2 or HDMI2*5

D-Video EasyMP

USB Display USB or USB1

USB2 LAN

HDBaseT Whiteboard

Screen Mirroring HDMI3

F Temperature level

The following five icons display the differing internal temperature 
status of the projector.

Internal temperature 
normal

Internal temperature 
normal

High-temperature 
warning

High-temperature 
warning
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*1 When Temperature level display group view is set to On at Environment 
setup in the Tool menu, an icon indicating the internal temperature of the 
projector will be displayed on top of the projector icon. The default setting 
is Off.

*2 Check the following items.
- Check that the projector's power is turned on.
- Check that the LAN cable is connected.
- Check that Standby Mode is set to Communication On (or Network On) 
or Network Monitoring is set to On in the projector's configuration menu.

*3 Check that the projector has been correctly connected to the network.
*4 It describes DVI-D if the projector is equipped with both DVI-D and HDMI 

input terminal.
*5 It describes HDMI if the projector is equipped with both DVI-D and HDMI 

input terminal.
*6 You can display Replace Lamp at any time by setting a preset in the 

Environment setup in the Tool menu.

q Detectable error information differs with the projector you are using.

Internal temperature 
error

G Error information

Shows a warning/problem status using the following icons.

Replace Lamp*6 Replace Lamp (Lamp 1)

Replace Lamp (Lamp 2) Lamp error (Lamp 1)

Lamp error (Lamp 2) Lamp failure at power on 
(Lamp 1)

Lamp failure at power on 
(Lamp 2)

High-temperature warning

Replace Air Filter No Air Filter

Low Air Flow Air Flow Sensor Err.

Supply System Error (Ballast 
1)

Supply System Error (Ballast 
2)

Cinema filter warning Shutter warning

Lamp Cover Open Lamp Error

Lamp Error (Lamp 1) Lamp Error (Lamp 2)

Lamp failure at power on Lamp failure at power on 
(Lamp 1)

Lamp failure at power on 
(Lamp 2)

High internal temperature 
error

Low air flow error Air filter air flow sensor error

Internal Error Fan error

Sensor error Supply System Error 
(Ballast)

Supply System Error (Ballast 
1)

Supply System Error (Ballast 
2)

Auto Iris Error Cinema filter error

Shutter error Cooling system error 
(Peltier element)

Cooling system error 
(pump)

Other error

Exhaust vent shutter error Obstacle Detection warning 

Easy Interactive Function 
Error

Obstacle Detection Error

Projector Direction Warning Lamp Mismatch Warning

Laser Warning Incorrect Installation 
Position/Direction Warning

Phase Difference Plate Error Power Voltage Error

Lens Shift Error No Lens Error

Other Warning Laser Error
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Checking properties in detail

You can check the properties of Group and projectors in detail.

Displaying Group properties

Procedure

You can use either of the following methods to display the proper-
ties.
• Displaying the properties for all groups in Grouping view

Right-click in Grouping view and select Property.
• Displaying the specified group properties

Right-click an icon in Grouping view and then select Property.

If you double-click in a line, the properties for that group or projector 
will be displayed.

Displaying Projector properties 

Right-click on a projector icon in Grouping view or Detail list view and 
select Property.

Displaying and deleting logs

In your web browser, you can check a transmission log of content such as 
what has been controlled by EasyMP Monitor and projector errors. You 
can delete logs once you have checked them.

A Shows the projector's serial number. If hyphens are displayed, confirm 
the serial number on the label of the projector.

B Displays the projector firmware version.
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q When Log output is set to On at Environment setup in the Tool menu, 
transmission logs are stored. The default setting is Off.

Displaying Log

Procedure

Select "Log" - "View" from the View menu.
The web browser will open and the communication logs up until that 
time will be displayed.

Deleting Log

Procedure

Select "Log" - "Delete" from the View menu. When the confirma-
tion message is displayed, click "OK".
All logs will be deleted and details of EasyMP Monitor control operations 
and details of projector errors from that point onward will be recorded in 
a new log.

Outputting lamp hours as a CSV file

For projectors register in EasyMP Monitor, you can output the number 
of hours the lamp has been used as a CSV file so you can check and edit 
the data, if necessary. You can output a CSV file during projection 
without having to stop projecting.
The CSV file contains the following information:
• Projector name

• Display name
• IP address
• Lamp Hours (Lamp 1)
• Lamp Hours (Lamp 2)
• Description

Procedure

A Select "Export" from the File menu.

B Select the location where you want to save the file and select 
Save.

q • You may not be able to select Export right after starting EasyMP Monitor. 
If this happens, wait for about five minutes and select Export.

• Information about all of the projectors registered as monitored projectors 
in EasyMP Monitor is output in a CSV file. You cannout output 
information about a specific projector.
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Using the control functions

Carrying out control using control buttons

Click the icon of a projector to be controlled in Grouping view or Detail 
list view, and click a control button to enable control of only that selected 
projector.
You can also enable control of all selected projectors by selecting more 
than one projector in Grouping view or Detail list view and clicking a 
control button. The methods of selecting more than one projector at the 
same time are as follows.

• If you select a group icon in Grouping view, all projectors that have been 
registered in that group and that are set to be monitored can be 
controlled at the same time.

• Hold down the Ctrl key on the keyboard while clicking on the desired 
icons.

• Use drag and drop to select a range of desired icons.
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The following table shows the meanings of the control buttons.

* If the button does not function, you can switch the input source using the 
 button.

Power On Turns the projector power on.

 Power Off Turns the projector power off.

 Switch source 
Computer1

Switches the input source to the Computer1 
port or Computer port.

 Switch source 
Computer 2

Switches the input source to the Computer2 
port.

 Switch source 
BNC

Switches the input source to the BNC port.

 Switch source 
S-Video

Switches the input source to the S-Video port.

 Switch source 
Video (RCA)

Switches the input source to the Video port or 
video2 port.

 Switch source 
Video (BNC)

Switches the input source to the Video1 port.

Switch source 
SDI

Switches the input source to the SDI port.

Switch source 
HDBaseT

Switches the input source to the HDBaseT 
port.

Switch source 
DisplayPort

Switches the input source to the DisplayPort 
port.

 Switch source 
DVI-D, HDMI 1

Switches the input source to the DVI-D1 port 
or HDMI1 port.
If the projector is equipped with either a 
DVI-D port or HDMI port, use this button to 
switch the input signal.
If the projector is equipped with both DVI-D 
port and HDMI port, use this button to select 
DVI-D as an input source.

 Switch source 
DVI-D, HDMI 2

Switches the input source to the DVI-D2 port 
or HDMI2 port.
If the projector is equipped with both DVI-D 
port and HDMI port, use this button to select 
HDMI as an input source.

Switch source 
DVI-D, HDMI 3

Switches the input source to the HDMI3 port.

 Switch source 
D-Video

Switches the input source to the D4 port.

 Switch source 
EasyMP

Switches the input source to EasyMP or 
EasyMP.net.

 Switch source 
USB Display*

Switches the input source to USB Display.

 Switch source 
USB1*

Switches the input source to the external 
equipment connected via a USB (Type A) port 
or USB1.

 Switch source 
USB2*

Switches the input source to the external 
equipment connected via a USB2 port.

 Switch source 
LAN*

Switches the input source to the image 
projected by the computer via a network.

Switch source 
Whiteboard

Switches the input source to Whiteboard.

Switch source 
Screen 
Mirroring

Switches the input source to Screen Mirroring.
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q • Some connected projectors may not be equipped with all of the above ports 
or functions. If you click a button for a port or function that is not 
available, nothing will happen.

• You can select objects to be controlled and use the control buttons to carry 
out control operations even when the following are being displayed.
Group properties s p.33
Projector properties s p.33
Warning and Error Projector list
(Control operations can only be carried out for projectors with a warning 
status.) s p.29

Carrying out control using a web browser (Web 
control)

You can use the computer's web browser to change the configuration 
menu settings for projectors.

Procedure

A Right-click on the icon of a projector to be controlled in 
Grouping view or Detail list view and select "Web control".

B The web browser will open and the Web control window will 
be displayed.

Web control lets you set the same details as the configuration menu for 
the projector. See your User's Guide for more information.

q You can select projectors and right-click on them to select Web control 
even when the following are being displayed.
Group properties s p.33
Warning and Error Projector list (Control operations can only be carried 
out for projectors with a warning status.) s p.29

Carrying out control using timer settings

This is useful for carrying out certain control operations such as turning 
a projector's power on and off at specified times every day or every week.
Timer settings can be carried out either for a single projector only, or all 
at once for all projectors in a group.
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Procedure

Select "Timer" - "Timer Settings" from the Tool menu.
The following window will be displayed and you can then check the timer 
setting status.

The details that can be checked and operations that can be carried out at 
this time are given below.

A Projectors

Selects a group or projector to check the status of.

When a group is selected, the timer setting statuses for all projectors 
in that group are displayed.

B Date

Shows the current day in a red box.

Days for which timer settings have been made are shown in bold.

Click  or  to switch to the calendar for the previous or next 
month.

C Timers

Shows a list of the timer settings.

The line colors in the Timers list have the following meanings:

Current day's timer 
setting

When some of the projectors in the group have timer 
setting enabled and others have it disabled for the 
current day's timer setting

When the current day's timer setting is a disabled setting

Timer setting for a day other than the current day

D Delete

Lets you delete timer settings that have been selected 
from the timer list.

E Close

Closes the Timer Settings window.

F Edit

Lets you change the timer settings that have been 
selected from the timer list. If a group has been selected 
for status checking, the settings cannot be changed.

G Add

Registers new timer settings. (See the next section for 
more information.)

H Enabled/Disabled

Switches the timer settings that have been selected from 
the timer list between Enabled and Disabled.
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Procedures for new timer settings

Procedure

A Click "Add" on the Timer Settings window. The following 
window is displayed and the new timer settings are applied.

At Operation, you can carry out the operations of turning the pow-
er on and off and switching the input sources, similarly for the con-
trol buttons on the main window. If you set the input source 
switching, the projector's power will turn on at the timer start time 
even if it is not on at the time. Because of this, it is not necessary to 
make two separate timer settings for turning the power on and 
switching the input source.

B After completing the timer settings, click "OK".
The timer settings that have been made will be registered and they 
can be checked in the displayed timer list.

q You can enable and disable all of the timer settings that have been 
registered. Select Timer - Enable or Disable from the Tool menu.
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Mail notification function settings

The mail notification function can be used to send corresponding 
notification messages to a preset e-mail address when a projector that is 
connected to the network assumes a certain status, or if it experiences a 
problem or warning. By using this function, the operator can be notified 
of a projector’s status or problems even when the operator is in a 
different location from the projectors.

q • Up to three addressees (destinations) can be registered and messages can be 
sent to all of them at once.

• If a critical problem develops with a projector which causes it to suddenly 
stop working, it may not be possible for the projector to send a message 
notifying an operator of the problem.

• If Standby Mode is set to Communication On (or Network On) or Network 
Monitoring is set to On in the projector configuration menus, you can 
monitor the projector even when it is in standby mode (when its power is 
turned off). See your User's Guide for more information.

• On some projectors, the mail notification function can be set in the 
configuration menu. When notification messages are set to be sent in the 
projector's configuration menu, both the settings in the configuration menu 
and settings made on EasyMP Monitor are functional.

• Detectable status with the mail notification function differs with the 
projector you are using.

Procedure

A Select "Mail notification function" from the Tool menu.

B The Set mail notification function window will be displayed.

Make the necessary settings while referring to the table below.

Mail notification 
function

Set to On to use the mail notification function.

SMTP server IP 
address

Enter the IP address of the SMTP server. Up to 
a maximum of 255 bytes can be entered.

When you change a port number of the SMTP 
server, specify this port number. The default 
value is "25".

You can enter a valid number from 1 to 65535.

Sender mail 
address

Enter the sender's e-mail address. Up to a 
maximum of 255 bytes can be entered.

Recipient mail 
address 1

Specify the destination addresses for the 
notification e-mail. Up to three destinations 
can be set. Up to a maximum of 255 bytes can 
be entered.

Recipient mail 
address 2

Recipient mail 
address 3
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C Click "Notification event" and check the items for mail 
notification in the window that appears.

D Click "OK".
The Set mail notification function window appears again.
Repeat Steps 3 and 4 to set the notification events for the other 
email addresses.

E When the setup is complete, click "OK".
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An e-mail notifying the operator of a problem/warning/status is issued

If the projector experiences a problem or enters a status requiring 
attention, an e-mail like that shown below is sent to the address specified 
for Recipient mail address.
If there is more than one problem, warning, or status, the corresponding 
messages are output to separate lines.

Item Details shown

E-mail subject [Display name displayed in Grouping view or Detail 
list view] Projector status notification

Body <Display name displayed in Grouping view or Detail 
list view> has entered the following status.

<Warning/error/status message> (Please see the 
next table)
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The details contained in the e-mail message can consist of the following.

Message Remedy

Easy Interactive 
Function Error

Stop using the projector, disconnect the power 
cable from the electrical outlet, and contact Epson. 
See your User's Guide for more information.Internal Error

Fan error

Sensor error

Lamp Cover Open See your User's Guide for more information.

Lamp failure at power 
on*

Lamp Error*

Lamp Mismatch 
Warning

Projector Direction 
Warning

Supply System Error 
(Ballast)*

Stop using the projector, disconnect the power 
cable from the electrical outlet, and contact Epson. 
See your User's Guide for more information.High internal 

temperature error

Low air flow error

Exhaust vent shutter 
error

Cinema filter error

Shutter error

Cooling system error 
(Peltier element)

Cooling system error 
(pump)

Auto Iris Error

Phase Difference 
Plate Error

Stop using the projector, disconnect the power 
cable from the electrical outlet, and contact Epson. 
See your User's Guide for more information.Power Voltage Error

Lens Shift Error

Laser Error

Laser Warning

High-temperature 
warning

See your User's Guide for more information.

Replace Lamp*

Supply System Error 
(Ballast)*

Replace Air Filter

No Air Filter

Low Air Flow

Air Flow Sensor Err.

Air filter air flow 
sensor error

Cinema filter warning

Shutter warning

Clean Air Filter Notice

Obstacle Detection 
Error

Obstacle Detection 
Warning

Low air flow error

High internal 
temperature error

Message Remedy
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* When the projector has 2 lamps, the additional information, such as (Lamp 
1) or (Ballast 1), is displayed after the message so that you can know which 
lamp has problems/warnings.

Messages to inform that the projector has recovered from the error or 
warning statuses are sent.

Other warning See your User's Guide for more information.

Other error

Incorrect Installation 
Position/Direction 
Warning

No signal No image signals are being received by the 
projector. Check the connection status and check 
that the power for the connected equipment is 
turned on.

Network error (TCP 
connection error)

Check the following items.

Check that the projector's power is turned on.
Check that the LAN cable is connected.
Check that Standby Mode is set to Communication 
On (or Network On) or Network Monitoring is set to 
On in the projector's configuration menu.

 See your User's Guide for more information.

Network error 
(ESC/VP.net 
communication error)

Check that the projector has been correctly 
connected to the network. See your User's Guide for 
more information.

Network error 
(Monitor Password 
authentication error)

Check the projector's Monitor Password.

No lens error Check that the lens is installed in the projector 
correctly. See your User's Guide for more 
information.

Message Remedy
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Application lock function

You can use the application lock to prevent third parties from operating 
the projectors using EasyMP Monitor and from changing settings 
without authority. Opening and closing EasyMP Monitor and status 
monitoring can still be carried out even when the application lock is 
applied.
In addition, when a password has been set, the password must be entered 
in order to cancel the application lock. This ensures that the application 
lock can not be easily cancelled, and thus improves system security.

Switching Application lock between Enabled and 
Disabled

Enabling the application lock

Procedure

Select "Application lock" from the Tool menu.
The application lock will be enabled and no operations will be possible 
other than opening and closing EasyMP Monitor and disabling the 
application lock.

Disabling the application lock

Procedure

A Select "Application unlock" from the Tool menu.

B The password entry window will be displayed, so enter the 
set password and then click "OK".
If no password has been set (default setting), click OK without en-
tering a password. It is recommended that you enter a password in 
order to strengthen security.
The application lock will be cancelled and operations can be carried 
out as normal.

Setting a password for cancelling application lock

Carry out the following operations while application lock is cancelled.

Procedure

A Select "Environment setup" from the Tool menu.
The Environment setup window will be displayed.

B Select "Change the application lock password".

C Enter the password in both the "New password" and "New 
password (confirm)" boxes and then click "OK".
The password can be up to 16 bytes in length. Single-byte alphanu-
meric characters can be used.
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Troubleshooting

Projectors cannot be monitored or controlled

An e-mail message is not sent when a problem occurs 
with a projector

Cause Remedy

Is the projector connected 
to the network correctly?

Check that the network cable has been 
connected correctly. If the cable is not 
connected correctly, reconnect it.

Has the projector been set 
up correctly for 
connection to the 
network?

Check the Network configuration settings.

See your User's Guide for more information.

Has EasyMP Monitor been 
installed on the computer 
correctly?

Uninstall EasyMP Monitor and then re-install 
it.s p.8

Are all the projectors that 
you want to control or 
monitor registered?

Register the projectors. s p.11

Is the projector's Standby 
Mode set to 
Communication On (or 
Network On) or Network 
Monitoring set to On in the 
configuration menu?

In order to use EasyMP Monitor to monitor and 
control the projector when it is in standby 
mode, the projector's Standby Mode must be 
set to Communication On (or Network On) or 
Network Monitoring must be set to On in the 
configuration menu.

See your User's Guide for more information.

Cause Remedy

Is the projector connected 
to the network correctly?

Check that the network cable has been 
connected correctly. If the cable is not 
connected correctly, reconnect it.

Has the projector been set 
up correctly for 
connection to the 
network?

Check the Network configuration settings.

See your User's Guide for more information.

Have the SMTP server IP 
address, Port Number and 
Recipient mail address all 
been set correctly?

Check the setting details.

Is the projector's Standby 
Mode set to 
Communication On (or 
Network On) or Network 
Monitoring set to On in the 
configuration menu?

In order to use EasyMP Monitor to monitor and 
control the projector when it is in standby 
mode, the projector's Standby Mode must be 
set to Communication On (or Network On) or 
Network Monitoring must be set to On in the 
configuration menu.

See your User's Guide for more information.

Has a critical problem 
developed causing the 
projector to momentarily 
stop working?

When the projector has momentarily stopped 
working, it cannot send e-mail messages. If the 
projector cannot be reset even after it has 
been checked, contact Epson. See your User's 
Guide for more information.

Is power being supplied to 
the projector?

Check if the power supply to the location 
where the projector is set up has been 
interrupted, or if the circuit breaker for the 
electrical outlet that the projector is 
connected to has been tripped.
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Uninstalling EasyMP Monitor

To save or transfer the existing projector settings, make a copy of the 
EMP Monitor.dat file before you uninstall the software. 
s "Transferring the settings" p.7
The following procedures to uninstall EasyMP Monitor vary depending 
on your operating system.
• If your operating system is Windows 2000 or Windows XP 

Click Start - (Settings) - Control Panel - Add/Remove Programs or 
Add or Remove Programs to uninstall EasyMP Monitor. 

• If your operating system is Windows Vista, Windows 7, or Windows 10
Click Start - Control Panel - Uninstall a program to uninstall EasyMP 
Monitor. 

q If your operating system is Windows 10, right-click "Start" and click 
"Control Panel".

• If your operating system is Windows 8.x
From the Start menu, right-click "EasyMP Monitor Ver.x.x.xx" and 
select "Uninstall" to uninstall EasyMP Monitor.

q With Windows Vista, Windows 7, Windows 8.x, and Windows 10, settings 
and logs remain on the hard disk even after EasyMP Monitor is uninstalled. 
If you do not need this information, delete the EasyMP Monitor Ver. x.xx 
(Ver. x.xx represents the version of the existing software) folder. This folder 
can be found at "C:\Users\(User 
Name)\AppData\Local\VirtualStore\Program Files\EPSON Projector" if 
the default settings were used to install the software.
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General Notice

All rights reserved. No part of this publication may be reproduced, stored 
in a retrieval system, or transmitted in any form or by any means, 
electronic, mechanical, photocopying, recording, or otherwise, without 
the prior written permission of Seiko Epson Corporation. No patent 
liability is assumed with respect to the use of the information contained 
herein. Neither is any liability assumed for damages resulting from the 
use of the information contained herein.
Neither Seiko Epson Corporation nor its affiliates shall be liable to the 
purchaser of this product or third parties for damages, losses, costs, or 
expenses incurred by the purchaser or third parties as a result of: 
accident, misuse, or abuse of this product or unauthorized modifications, 
repairs, or alterations to this product, or (excluding the U.S.) failure to 
strictly comply with Seiko Epson Corporation's operating and 
maintenance instructions.
Seiko Epson Corporation shall not be liable against any damages or 
problems arising from the use of any options or any consumable 
products other than those designated as Original Epson Products or 
Epson Approved Products by Seiko Epson Corporation.
This information is subject to change without notice.
Illustrations in this guide and the actual projector may differ.

Trademarks

Microsoft, Windows, Windows Vista, and the Windows logo are 
trademarks of Microsoft Corporation in the United States of America 
and other countries.
Macintosh is a trademark of Apple Inc., registered in the U.S. and other 
countries.
Pentium is a registered trademark of Intel Corporation.
EPSON, EasyMP, and EasyMP.net are registered trademarks, and 
EPSON Exceed Your Vision is a registered logomark of Seiko Epson 
Corporation.
Other product names used herein are also for identification purposes 
only and may be trademarks of their respective owners. Epson disclaims 
any and all rights in those marks.

©2016 Epson America, Inc.
9/16
CPD-52395
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